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1/ Sâu hại:

a) Rệp sáp: Rệp mày trắng có tua sáp quanh mình, 
phần đuôi có 8 tua rất dài (tên khoa học: Pseudococcus 
longispinus). Rệp chích hút nhựa lá tạo ra những mảng 
trắng ở gân chính, gân phụ. Rệp cộng sinh với kiến vì 
chúng tiết ra chất ngọt, lại lôi cuốn thêm bệnh bồ hóng.

xem tieáp trang 9

Nếu máy tính có nhiều người dùng chung thì một 
tài khoản quản trị (administrator) sẽ đóng một vai 
trò quan trọng. Nó giúp bạn dễ dàng quản lý các tài 
khoản người dùng hiện có và đặc biệt là khôi phục 
lại mật khẩu trong trường hợp họ lỡ quên mất. Nếu 
bạn dùng Windows XP thì theo mặc định, tài khoản 
administrator sẽ tự động được bật, ngược lại nếu 

Trong một động thái củng cố thực lực trước khi 
Apple chính thức lấn sân vào lĩnh vực TV, Google hồi 
đầu tuần tuyên bố sẽ tiến hành đợt nâng cấp quan 
trọng cho Google TV, cho phép người dùng dễ dàng 
xem video và truy cập đủ loại kênh trên chiếc ti-vi 
trong phòng khách

Google cũng cập nhật tính năng mới gọi là 
Discover, cho phép mọi người xem YouTube có thể 

xem tieáp trang 6

Nông dân Hậu Giang đang dùng nấm xanh phun 
trên ruộng lúa Đông Xuân, không những đạt hiệu 
quả cao trong phòng trừ sâu bệnh mà còn góp phần 
bảo vệ môi trường trên đồng ruộng.

Để gieo cấy nấm xanh, người dân cần chuẩn bị 
nguyên liệu gạo tấm và nấm gốc, các dụng cụ gồm nồi 
hấp, tủ cấy, bọc nilon và ống nhựa. Tấm được ngâm 
trong nước rồi cho vào nồi hấp, sau đó trộn với nấm gốc, 

xem tieáp trang 4

xem tieáp trang 15

xem tieáp trang 4

Nếu bạn đang tìm kiếm một chiếc máy ảnh bỏ túi 
nhưng lại có ngân sách eo hẹp, bạn sẽ phải tìm hiểu 
một vài model để có thể mua được một chiếc máy ảnh 
với chất lượng ưng ý nhưng giá thành chấp nhận được. 

Không phải bàn cãi, bạn sẽ phải hy sinh một số 
tính năng và chất lượng hình ảnh ở mức giá dưới 130 
USD. Bạn sẽ không tìm thấy ống kính zoom dài, khả 
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1.PHÂN Ủ:
Những dạng phân hữu cơ truyền thống mà từ 

xa xưa cho tới nay nhà nông phải sử dụng phân 
chuồng (heo, trâu, bò, gia cầm...), phân xanh. 
Ngay cả việc cày độn rạ, ủ gốc rạ tại ruộng cũng 
là biện pháp chế biến phân hữu cơ. Ấy là chưa 
kể việc lấy bùn ao bón ruộng thực chất cũng là 
tận dụng nguồn hữu cơ có sẵn. Cho nên ngay 
khi còn chưa có phân hóa học, cha ông ta đã coi 
phân bón là yếu tố thứ hai làm nên bội thu cho 
mùa màng: “Nhất nước nhì phân...”

Sở dĩ như vậy vì nhà nông hiểu rằng độ phì 
nhiêu của đất canh tác không chỉ gồm các dưỡng 
chất cơ bản NPK mà còn có cả những chất mùn 
sinh ra từ xác cỏ cây thối rửa trong đất. Ngày nay 
khoa học đã chỉ ra rằng khi nằm trong đất với độ 
ẩm ướt nhất định, các xác cây sẽ phân huỷ bởi 
tác động của vi sinh vật trở thành chất mùn phân 
bố trong đất và như đã nói ở chương trước, chất 
mùn đó là một vật liệu chính cải thiện những tính 
chất lý hóa của đất, đặc biệt góp phần quan trọng 
tạo nên hệ keo đất.

Cái mà ngày nay người ta gọi là phân ủ (còn 
thuật ngữ các nước là compost) thì thực ra nó 
đã được người nông dân chế biến rất lâu với 
những cái tên phân mục, phân hoai...Bà con trộn 
phân chuồng với rơm rạ, xác cỏ cây, vun thành 
đống hình chóp tròn, phủ bằng một lớp đất bùn 
đất. Sau 3-4 tháng đem bón rất hiệu quả, nhất là 
đối với các loại hoa màu vụ đông. Ngoài ra, khi 

sử dụng phân ủ, ta tránh được ô nhiễm do dùng 
phân tươi. Ở miền Bắc trong những năm sáu 
mươi của thế kỉ trước, phong trào “sạch làng tốt 
ruộng”, phát triển bèo hoa dâu và các loại phân 
xanh khác cũng đã xác lập được công thức ủ 
phân rất tốt, góp phần tích cực nâng cao năng 
suất lúa và các loại hoa màu khác.

Như thấy ở trên, công nghệ ủ phân nước 
ta cũng như nhiều nước tiến hành đều có hai 
nguyên liệu chính:

- Xác cây cỏ, rơm rạ, rác thải... gọi chung là 
rác độn.

- Phân động vật, có tác dụng gây men kích 
thích quá trình phân hủy.

Có thể không nên dùng phân men, nhưng thời 
gian ủ sẽ bị kéo dài. Ngoài ra để tăng hiệu quả 
của quá trình ủ người ta bổ sung một ít  phân hóa 
học nhằm cân đối thành phần các dưỡng chất 
đồng thời để nuôi các vi khuẩn phân huỷ. Một số 
phụ liệu như vôi, bột đá, than bùn, bột đất... cũng 
được thêm vào; tất nhiên nước là vật liệu không 
thể thiếu.

Cùng với các bộ môn khoa học khác, hóa học 
góp phần đắc lực vào công nghệ ủ phân bằng 
cách xác lập thành phần hóa học từ các nguyên 
liệu và trong sản phẩm phân bón, các yếu tố ảnh 
hưởng đến quá trình ủ. Dưới đây một vài số liệu:

TS Nguyễn Đức Thạch Hội Hóa học Đồng Nai
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Xem tieáp trang 7

Chắc hẳn trong giới chơi audio 
lossless, ai đều có lúc gặp rắc rối 
với việc ghi các file nhạc định dạng 
lossless này sang CD để có thể đọc 
được trên các đầu CD dân dụng 
mà không giảm thiểu chất lượng 
âm thanh sau khi ghi ra đĩa. Thông 
thường, người rip 1 CD ra định dạng 
lossless (thông thường bằng phần 
mềm EAC) sẽ đi kèm cho chúng 1 ta 
một hoặc nhiều file *.flac hay *.ape, 
1 file *.cue để lưu trữ thông tin về 
đĩa CD chúng ta đã rip, 1 file *.log để 
ghi lại quá trình rip như thế nào. Đa 
phần mọi người sẽ sử dụng chương 
trình ghi đĩa phổ biến như Nero để 
mở file *.cue lên và tiến hành ghi. 
Tuy nhiên, một số file *.cue bị lỗi 
trong quá trình rip, và không phải 
ai cũng có thể thực hiện được việc 
sửa lỗi trên các file *.cue này. Việc 
này dẫn tới là chúng ta phải dùng tới 
phần mềm để chuyển đổi định dạng 
file .flac (.ape) sang định dạng *.wav 
để có thể ghi lên được CD bình 
thường. Điều này, theo đánh giá mọi 
người không đạt được tiêu chí hay 
yêu cầu về chuẩn âm thanh đầu ra. 
Vì từ một CD với các file dạng .wav, 
qua quá trình rip lại đưa về lossless 
(flac, ape), rồi lại chuyển từ lossless 
sang .wav, trong quá trình phân tích 
phổ tín hiệu, chúng ta thấy âm thanh 

và chất lượng đã suy giảm phần 
nào. Tuy nhiên, chẳng cần đi đâu xa, 
chuyển đổi định dạng file mất thời 
gian, chúng ta vẫn có thể ghi lên CD 
mà không cần phải dùng một phần 
mềm nào khác ngoài Foobar – phần 
mềm quá nổi tiếng trong giới chơi 
audio lossless ở Việt Nam cũng như 
trên thế giới. 

Sau khi chọn các bài hát cần 
ghi vào playlist của foobar, bạn chỉ 
cần chọn tất cả bài hát đó (Ctrl + A : 
Select all), rồi sau đó chọn Convert 
-> Write Audio CD. Một cửa sổ Write 
Audio CD sẽ hiện ra, cho phép 
chúng ta chọn ổ đĩa CD nào để ghi, 
cho phép chúng ta điều chỉnh hay 
thêm vào một số bộ xử lý tín hiệu số 
(DSP Processing). 

Bạn chỉ cần chọn những bộ DSP 
ở cửa sổ Available DSPs và đưa 
vào cửa sổ Active DSPs. Ở đây, 

Foobar hỗ trợ sẵn những bộ xử lý tín 
hiệu thường dùng như Equalizer, bộ 
chuyển đổi âm thanh vòm 5.1 sang 
Stereo, hay từ Mono sang Stereo…
Bạn có thể chọn thêm từ ngoài bằng 
việc load các preset DSP bạn tải trên 
mạng về. Sau khi chọn xong thì một 
số bộ cho phép bạn cấu hình chúng, 
ví dụ như Equalizer cho phép bạn 
cấu hình âm treble – midle – bass 
cho phù hợp với dàn âm thanh của 
bạn. Sau khi cấu hình xong nhấp 
OK để Foobar đưa vào thông số cho 
quá trình ghi. Sau đó, bạn nhấp OK 
(dĩ nhiên là phải để CD trắng vào ổ 
đĩa đã )để bắt đầu quá trình ghi. Và 
a lê hấp, bạn đã ghi xong 1 CD từ 
định dạng lossless và có thể chơi 
trên đầu đĩa dân dụng của bạn mà 
không phải gặp rắc rối, và mệt mỏi 
chuyển đổi như trước nữa. 

Lương Gia Định

Sau khi phát hành phiên bản của Firefox 4 đến 
nay, Mozilla từng bước tiến hành tân trang cửa sổ 
quản lý add-on của trình duyệt. Có rất nhiều các 
tiện ích như themes, plug-in, userscripts được tích 
hợp cùng một nhóm quản lý nhưng cách nhau bằng 
tab. Nhìn chung, các chức năng đó có nhiều cải 
tiến tốt hơn so với add-on quản lý cũ nhưng sử 
dụng quá nhiều không gian. Dưới đây là một số tiện 
ích sửa chữa các lỗ hổng khác nhau mới về quản 
lý add-on:

1. Cleanest Addon Manager
Add-on nhỏ này sẽ giải phóng không gian lãng 

phí về quản lý cửa sổ add-on bằng cách giảm chiều 
cao và kích thước font chữ. Nó có thể rất hữu ích 
nếu bạn có một danh sách dài của các addons và 
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cho vào bọc nilon và ủ trong vòng 
14 ngày. Nấm thành phẩm được lọc 
lấy nước, trộn với chất bám dính và 
nước để phun trên ruộng. Do nấm 
thành phẩm có màu xanh nên được 
nông dân gọi là nấm xanh.

Nấm xanh được phun 
hai lần trong một vụ lúa, 
lần 1 vào lúc cây lúa được 
25-30 ngày, lần hai vào lúc 
cây lúa 50-55 ngày. Chi phí 
gieo cấy nấm xanh khoảng 
100.000 đồng/ha, giảm 
khoảng 5 lần so với việc 
sử dụng thuốc trừ sâu, tiết 
kiệm cho người nông dân 
từ 700.000 đồng đến 1 triệu 
đồng/ha trong một vụ lúa. 
Nấm xanh khi phun vào cây 
lúa sẽ ký sinh và phát triển 
trên cơ thể côn trùng, làm 
côn trùng bị tiêu diệt, nhất là các loại 
rầy nâu, sâu cuốn lá, sâu keo.

Bà Lê Thị Như Thùy, Chi cục phó 
Chi cục Bảo vệ thực vật tỉnh Hậu 

Giang, cho biết dự án ứng dụng 
nấm xanh trên cây lúa được Chi 
cục thực hiện từ vụ lúa Đông Xuân 
2010-2011 ở 8 điểm, sang vụ Hè 
Thu năm 2011 thực hiện ở 12 điểm. 

Người dân được hỗ trợ nguyên, vật 
liệu và được hướng dẫn cách gieo 
cấy nấm, sử dụng trên ruộng.

Vụ lúa Đông Xuân 2012, Chi cục 

thực hiện 17 điểm gieo cấy nấm xanh 
dùng cho khoảng 250ha, hỗ trợ một 
phần nguyên liệu và hướng dẫn kỹ 
thuật cho nông dân. Ở những điểm 
thực hiện gieo cấy nấm xanh trong 

các vụ trước, người dân đã 
tự gieo cấy nấm xanh để 
dùng trên ruộng lúa.

Do nấm xanh đạt hiệu 
quả cao trong việc phòng 
trừ sâu bệnh trên cây lúa, lại 
không ảnh hưởng đến sức 
khỏe người sử dụng, góp 
phần bảo vệ môi trường, 
nhất là giảm chi phí sản 
xuất cho người nông dân, 
Chi cục Bảo vệ thực vật tỉnh 
Hậu Giang đang có hướng 
mở rộng mô hình gieo cấy 
nấm xanh, hướng dẫn cho 
nhiều nông dân biết cách 

thực hiện và sử dụng nấm xanh 
trong những vụ lúa tới.

Quang thoại 

năng quay Full HD video 1080p, 
kết nối GPS, chụp ảnh 3D, hoặc 
khả năng chụp trong điều kiện 
thiếu sáng. Hầu hết các model 
đều bao gồm một màn hình LCD 
nhỏ, ngoại trử Nikon Coolpix L24 
và Kodak EasyShare C1530 được 
trang bị màn hình 3-inch. Nói 

chung, nếu bạn sẵn sàng ưu tiên 
những gì quan trọng nhất khi nói 
đến tính năng và hiệu suất, bạn 
có thể tìm thấy sự hài lòng với các 
model máy ảnh có mức giá thấp.

Trong đó, model được nhiều 
người yêu thích không có gì đáng 
ngạc nhiên bởi nó là model có giá 
đắt nhất (130 USD) đó chính là 
Panasonic Lumix DMC-S3 với một 
ống kính zoom góc rộng, pin sạc và 
khả năng quay HD video 720p. Tuy 
nhiên, Canon PowerShot A800 và 
Samsung ES80 lại cho chất lượng 
hình ảnh rất tốt với mức giá dưới 
100 USD. Sau đây là danh sách 
của 08 máy ảnh có giá dưới 130 
USD mà bạn cần quan tâm. 

1/ Canon PowerShot A800 
(3/5 sao) – Giá bán 89.99 USD

Máy ảnh bỏ túi này đi kèm với 
một sự thỏa hiệp, bởi với mức giá 
gần 90 USD, máy ảnh này thiếu ổn 
định hình ảnh quang học. Không 
quay video độ nét cao. Độ phân 
giải màn hình LCD thấp.

2/ Fujifilm FinePix AV200 (3/5 
sao) – Giá bán 89.95 USD

Fujifilm FinePix AV200 là một 

Xem tieáp trang 5

Nông dân pha xịt nấm xanh
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máy ảnh rẻ tiền nhưng nó có màn 
hình LCD hiển thị tốt và có thể 
chụp hình ảnh sắc nét cũng như 
quay HD video 720p, nhưng bù lại 
hiệu suất hoạt động của nó chậm, 
sử dụng pin AA và hình ảnh bị 
nhiễu (noisy).

3/ General Electric J1470S 
(4/5 sao) – Giá bán 119,99 USD

Mặc dù General Electric J1470S 
là máy ảnh bỏ túi giá rẻ tương ứng 
với “ngoại hình” của nó nhưng sức 
mạnh hình ảnh và hiệu suất của 
nó nói chung là ấn tượng đối với 
một máy ảnh point-and-shoot có 
giá120 USD bởi nó được trang bị 
một ống kính có zoom 7x và có khả 
năng quay HD video 720p. 

4/ Kodak EasyShare C1530 
(2,5/5 sao) – Giá bán 79,95 USD

Kodak EasyShare C1530 được 
trang bị một màn hình LCD lớn do 
đó mang lại hình ảnh sắc nét với 
một mức giá rất khiêm tốn, nhưng 
khả năng chụp ảnh trong điều kiện 
thiếu sáng và khả năng quay video 
lại là một khuyết điểm lớn của máy 

ảnh này.

5/ Nikon Coolpix L24 (2/5 sao) 
– Giá bán 119,95 USD

Nikon Coolpix L24 ngoài việc 
được trang bị một màn hình LCD 
lớn (3-inch) thì nó lại có nhiều 
khiếm khuyết về chất lượng hình 
ảnh như : độ nhiễu hình ảnh cao. 
Thiếu hỗ trợ chụp ảnh trong điều 
kiện thiếu sáng. Không kiểm soát 
ISO. Sử dụng pin AA.

6/ Olympus T-100 (2/5 sao) – 
Giá bán 89,99 USD

Olympus T-100 là một máy ảnh 
nhỏ gọn có khả năng chụp một số 
hình ảnh khá sắc nét. Thật không 
may, nó bị cản trở bởi độ nhiễu 
hình ảnh cao, hiệu suất chậm, độ 
phân giải màn hình LCD thấp và 
phạm vi zoom ngắn.

7/ Panasonic Lumix DMC-S3 
(4/5 sao) – Giá bán 129,99 USD

Panasonic Lumix DMC-S3 là 
một máy ảnh bỏ túi được trang 
bị một màn hình LCD chất lượng 
cao (2.7 inch), pin sạc, khả năng 
quay video HD 720p và một ống 
kính góc rộng zoom 4x. Mặc dù nó 
không tạo ra những hình ảnh sắc 
nét nhất và không hỗ trợ zom khi 
quay video nhưng nó là một trong 
các máy ảnh tốt nhất với mức giá 
gần 130 USD.

8/ Samsung ES80 (3/5 sao) – 
Giá bán 99,99 USD

Samsung ES80 cung cấp cho 
người dùng những hình ảnh sắc 
nét trong điều kiện ánh sáng tốt, 
và không giống như hầu hết các 
máy ảnh có giá dưới 100 USD, 
Samsung ES80 được thiết kế khá 
nhỏ gọn và được trang bị một ống 
kính có zoom 5x. Tuy nhiên, hiệu 
suất ISO của nó khá nghèo nàn, độ 
phân giải màn hình LCD thấp, thời 
gian khởi động máy chậm. 

Võ Xuân Vỹ
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đang dùng Windows 7, bạn sẽ 
phải tự bật tài khoản này khi cần. 
Có nhiều cách để bật tài khoản 
administrator trong Windows 7 
nhưng cách nhanh nhất là chỉnh 
sửa registry. 

Đầu tiên, bạn khởi động máy 
tính bằng đĩa DVD cài đặt Windows 
7 chờ cho đến khi cửa sổ Install 
Windows xuất hiện, tại đây, bạn 
nhấn Next để xác nhận. 

Trong cửa sổ tiếp theo, bạn hãy 
bấm vào nút Repair your computer. 
Tiếp theo, bạn nhấn Next để xác 
nhận. Lúc này, trình cài đặt sẽ tự 
động tìm kiếm và phát hiện các 

vấn đề và có thể yêu cầu bạn sửa 
chữa chúng nếu có, bạn chỉ cần 
nhấn nút No mỗi khi có thông bào 
xuất hiện. Sau cùng,  bạn sẽ được 
đưa đến cửa sổ System Recovery 
Options. 

Tại đây, bạn nhấn chuột vào liên 
kết Command Prompt. Lúc này, 
cửa sổ command prompt sẽ xuất 
hiện, tại đây, bạn hãy gõ regedit 
rồi nhấn Enter để khởi động tiện 
ích Registry Editor. Tiếp theo, bạn 
hãy bấm chuột vào nhánh HKEY_
LOCAL_MACHINE sau đó vào 
menu File> Load Hive. 

Một cửa sổ có tên là Load 
Hive hiện ra, tại đây bạn hãy nhập 
%windir%\system32\config\SAM 
vào ô File name rồi nhấn Open 
để xác nhận. Thao tác này sẽ cho 
phép nạp nội dung của tập tin SAM 
(Security Accounts Manager) chứa 
thông tin mã hóa về tên tài khoản 
và mật khẩu vào Registry Editor. 

Bạn sẽ đặt tên cho hive sắp tạo 
này bằng một tên bất kỳ, ví dụ đặt 

tên là test. Tiếp theo, bạn tìm đến 
nhánh HKEY_LOCAL_MACHINE\
test\SAM\Domains\Account\Users. 
Sau đó nhấn chuột trái vào nhánh 
000001F4 nhấn đôi chuột vào giá 
trị F trong khung bên phải. 

Một cửa sổ mới hiện ra cho 
phép bạn thay đổi các giá trị của 
F. Bạn chỉ cần quan tâm đến giá 
trị của dòng 0038, tại đây, bạn hãy 
thay thế số 11 (disable) thành số 
10 (enable) rồi nhấn OK để xác 
nhận. 

Trở lại giao diện chính của 
Registry Editor, tại đây, bạn bấm 
chuột trái vào tên của hive đã tạo 
(trong ví dụ này là test) sau đó 
vào menu File> Unload Hive. Sau 
cùng, khởi động lại máy tính. Sau 
khi khởi động xong, bạn sẽ thấy tài 
khoản administrator đã được kích 
hoạt. 

Võ Xuân Vỹ
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bạn cần di chuyển mỗi khi muốn truy cập vào một 
addon nào đó.

Tải về tại địa chỉ: https://addons.mozilla.org/en-
US/firefox/addon/cam/ 

2. Classicish Add-on Manager
Add-on Manager có giao diện không khác gì so 

với add-on cổ điển. Tuy nhiên vẫn có một số ít các 
thay đổi mới ở tiện ích này là:

- Các nút và các yếu tố khác có nhiều màu sắc 
khác nhau tùy theo thiết lập của hệ thống.

- Dòng thông báo trạng thái (ví dụ như “will be 
enabled after you restart Firefox” có nghĩa là sẽ 
được kích hoạt sau khi bạn khởi động lại Firefox và 
“không tương thích với phiên bản này của Firefox”) 
được chuyển đến dưới cùng của các mục mở rộn . 
Cảnh báo không tương thích nếu thiết lập sai.

- Nút “Remove” và nút “Disable” được ẩn làm 
cho cửa sổ rộng hơn, nhưng vẫn dễ dàng có thể 
truy cập từ menu ngữ cảnh.

Tải về tại địa chỉ: https://addons.mozilla.org/en-
US/firefox/addon/classicish-addon-manager/ 

3. Addon Manager Firefox 4 
Tính năng này tạo giao diện cho firefox đầy màu 

sắc, ngoài việc thêm màu sắc, nó còn làm giảm 
chiều cao của cửa sổ, thêm và có thể truy cập 
các nút Enable All và Disable All  từ thanh công 
cụ Tools của thanh Menu sổ xuống, đặc biệt là nút 
Last Updated có thể cập nhật một số chương trình 
từ ngay cửa sổ.

Tải về tại địa chỉ: https://addons.mozilla.org/en-
US/firefox/addon/addon-manager-firefox-4/ 

4. Addon Manager Fix
Addon Manager Fix là một tiện ích được các nhà 

phát triển thiết kế có vô số màu sắc và các chức 
năng tương tự như Addon Manager Firefox 4

Tải về tại địa chỉ: https://addons.mozilla.org/en-
us/firefox/addon/addon-manager-fix/ 

5. Add-ons Manager Dialog Returns
Add-on này thay thế add-on quản lý cũ của 

Firefox bằng một cửa sổ riêng biệt, thay vì mở ra 
một tab mới. Bên cạnh đó, nó cũng mang lại một số 
cải tiến khác như: cung cấp một số phím tắt để điều 
hướng dễ dàng hơn, có thể thiết lập trang chủ quản 
lý add-ons như mặc định trang web Get Add-ons, 
hiển thị rõ các sản phẩm ở tab tìm kiếm trên addon.

Tải về tại địa chỉ: https://addons.mozilla.org/en-
US/firefox/addon/add-ons-manager-dialog-for-ff4/ 

Thành Trăm 
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Quan hệ cộng sinh là một mối quan hệ sinh thái cực 
kỳ phổ biến trong các quần xã sinh vật trên đất liền, 
ao hồ và dưới đại dương. Nó đóng vai trò quan trọng 
trong việc hợp thành các dạng sống chính trên trái đất 
và tạo ra sự đa dạng sinh học vô cùng phong phú. 
Đối với những loài thực vật, việc hợp tác với các loài 
vi khuẩn hoặc nấm chính là những phương thức hữu 
hiệu để nảy mầm, phát triển. Các loài sinh vật hợp tác 
này thường là đối tác trung gian để thu nhận các nguồn 
dinh dưỡng khan hiếm hoặc cũng có thể là lực lượng 
bảo vệ sinh vật cộng sinh khỏi các thiên địch hoặc loài 
gây bệnh bằng cách tiết ra các độc tố. Mối quan hệ 
hợp tác tương tự cũng diễn ra giữa thực vật và các 
loài côn trùng để chúng có thể chiếm cứ các ổ sinh thái 
với thức ăn từ các mô động thực vật khác nhau. Thông 
thường, mối quan hệ hợp tác này diễn ra ổn định qua 
các thế hệ. Một trong những mối quan hệ cộng sinh rõ 
nét nhất trong rừng mưa nhiệt đới Việt Nam giữa thực 
vật và côn trùng là loài cây ổ kiến có tên khoa học là 
Hydnophytum formicarum 

NHẬN DẠNG LOÀI DỊ THẢO

Cây ổ kiến Hydnophytum formicarum hay theo 
dân gian Việt Nam thường gọi Bí kỳ nam. Đây là loài 
thực vật phụ sinh, thân biến dạng thành củ. Phía dưới 
củ mọc ra những rễ nhỏ và phía trên mang cành lá, 
cành ngắn mập, màu nâu. Lá mọc đối phiến dày và dai 
hình trái xoan hoặc bầu dục, dài 6-9cm, rộng 2,5-6cm, 
gốc thuôn, đầu tù, hai mặt nhẵn, mặt trên sẫm bóng, 
mặt dưới nhạt. Lá kèm sớm rụng. Hoa không cuống, 
mọc tụ họp 4-5 cái ở nách lá, màu trắng. Quả nhỏ, hình 
trụ hơi dài, khi chín màu da cam.

MỐI CỘNG SINH CÓ CÙNG LỢI ÍCH SỐNG CÒN

Ngay từ khi hạt giống nảy mầm, bén dễ, bám vào 
sống phụ sinh trên các hốc cây hay các hốc đá, loài 
thực vật này đã có khả năng đi truyền từ hàng nhiều 
ngàn năm tiến hóa là tim cách cộng sinh với một loài 
kiến để cùng nhau phát triển trong thế giới sinh tồn 
đầy khó khăn của những loài sống bám. Những chiếc 
mầm non nhú lên cũng là lúc bộ dễ hút các dưỡng chất 
từ những tế bào chết, lớp mùn của cây chủ mà chúng 
sống bám. Để tồn tại những ngày đầu đời là một gian 
đoạn hết sức khó khăn để rồi theo năm tháng phần 
thân của gốc được tích tụ các dưỡng chất và bắt đầu 
phình lên và cũng là lúc các dưỡng chất xung quanh 
cây bám phụ ngày càng cạn kiệt. Phần được gọi là củ 
đã tạo nên các lỗ nhỏ phát triển lớn dần theo thời gian. 
Để có được sự giúp đỡ lâu dài phần củ bắt đầu tiết ra 
một số chất dẫn dụ loài kiến sống gần đó kéo nhau đến 
thưởng ngoạn bữa ăn. Nhận thấy cuộc sống mới là 
một nơi có khả năng chú thân rất tốt cho bầy đàn, cùng 
nguồn thức ăn đảm bảo. Lũ kiến bắt đầu kéo nhau về 
làm tổ ở một nơi hoàn toàn lý tưởng vừa kín đáo vừa 
sạch sẽ này. Thế là cuộc sống cộng sinh bắt đầu, cái 
củ cây ổ kiến tiếp tục lớn nhanh tạo thành một nơi bảo 
vệ vững chắc cho loài kiến cư trú. Đáp lại ân nhân loài 
kiến cũng trả lễ bằng cách tiêu diệt các loài sinh vật, 
côn trùng lạ tấn công loài cây mà cưu mang mình. Tuy 
nhiên cuộc sống hai bên vẫn tiếp diễn cho đến khi bầy 
kiến phát triển với số lượng lớn và nguồn chất dẫn dụ 
của cây ổ kiến cũng cạn dần. Loài kiến cũng bắt đầu tổ 
chức đi kiếm mồi, tha về tổ nuôi bầy và thế là một phần 
chất thải cũng như thức ăn của loài kiến được “chia 
phần” cho cây cùng phát triển  trong ngôi nhà mơ ước 

Xem tieáp trang 13
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Mùa xuất hiện nhiều từ tháng 5-12, 
nặng nhất là thời điểm thu hoạch; để 

diệt trừ cần phải phun thuốc trừ kiến 
vì chính loại kiến góp phần lây lan 
nhanh, bản thân riệp sáp bò rất chậm. 
Cắt tỉa thoáng lá, nếu đến mức phải 
phun thuốc (20% số cây nhiễm) dùng 
các loại thuốc sau đây: Supracid 40 
EC, Dimecron, Hostathion 40 EC... 
Kết hợp làm cỏ để giảm bớt chổ ẩn 
núp của kiến.

b) Rầy bông xoài: (Idiocerus sp.)

Giống con ve sầu, nhỏ dài độ 
2-3mm, mắt to (còn gọi là rầy nhảy 
mắt to). Chúng bu vào các phát hoa 
hút nhựa, tiết ra mật, làm cho nấm 
muội phát triển.

Mật độ rấy cao sẽ hạn chế sự đậu 
bông của xoài, làm hại cả đọt non và 
quả non

Cách phòng trừ: bẫy đèn, phun 
thuốc (Applaud MipC, Trebon).

c) Biện pháp phòng trừ tổng hợp:

- Vệ sinh vườn.

- Dùng thiên địch: bọ rùa, dòi ăn 
rệp cây ong ký sinh.

- Các biện pháp kỹ thuật: bón 
phân đủ, cân đối.

- Sử dụng đúng lúc, đúng liều, 
đúng đối tượng.

d) Bệnh cháy chóp lá: đầu ngọn lá 
bị khô làm giảm quang hợp. Bệnh do 
nấm Pestalotia mangiferae, thuộc bộ 
Melanconiales, lớp Imperfect.

e) Đốm lá: Trên bản lá xuất hiện 
nhiều đốm nâu đen nhỏ. Bệnh do nấm 
gromonia sp thuộc họ gromoniaceae.

f) Bệnh thán thư: Gây hại ở đọt 
non, lá, hoa, trái non gây ra vết đen 
hoặc làm bản lá biến dạng. Bệnh do 
nấm colletotrichum sp.

Biện pháp phòng trừ tổng hợp:

+ Vệ sinh đồng ruộng, vườn sạch 
sẽ, bón phân đầy đủ.

+ Phun thuốc: Antracol, Topsin M, 
Anvil, Kasuran, Metazeb, Mancozeb.

Nguyễn Cẩm Nhung

Một nghiên cứu mới đây cho thấy 
các phân tử DNA (còn được gọi là ADN 
– Acid deoxyribonucleic) trong cơ bắp bị 
thay đổi về mặt hóa học chỉ sau 20 phút  

tập thể dục với cường độ vừa phải.
Nhóm nghiên cứu thuộc Viện 

Karolinska ở Stockholm(Thụy Điển), đã 
làm thí nghiệm kiểm tra 14 đàn ông và 
phụ nữ khỏe mạnh nhưng ít vận động.

Họ để 14 người này tập thể dục ở các 
mức vận động khác nhau bằng một chiếc 
xe đạp trong phòng tập, và phân tích một 
số lượng nhỏ các mô cơ của người tham 
gia để theo dõi những thay đổi hóa học..

Họ đã phát hiện ra rằng mặc dù 
thành phần di truyền không thay đổi, 
song các phân tử DNA bên trong cơ bắp 
của người tham gia lại biến đổi về mặt 
cấu trúc và hóa học khi tập thể dục.

Giáo sư Juleen Zierath, trưởng 
nhóm nghiên cứu khẳng định: “Cơ bắp 
của chúng ta thực sự như được làm 
bằng chất dẻo vậy. Chúng ta thường nói 

“bạn là những gì mà bạn ăn”. Vâng, cơ 
bắp thích nghi với những gì mà bạn làm”

Ông Zierath nói thêm rằng nghiên 
cứu chứng minh tập thể dục mang 
lại những lợi ích to lớn cho tất cả mọi 
người. Ông nêu rõ: “Tập thể dục là liều 
thuốc bổ, và có vẻ như chúng ta chỉ cần 
chạy bộ là có thể làm thay đổi hệ gene 
để mang lại sức khỏe tốt hơn cho mình”. 

Cũng theo báo cáo của tạp chí Cell 
Metabolism thì “Chỉ cần với 20 phút tập 
thể dục bằng cách đạp xe đạp quanh căn 
nhà đã làm nên sự khác biệt” Tuy nhiên, 
các nhà khoa học cũng chỉ ra rằng, việc 
tập thể dục nhẹ nhàng thì không mang 
lại sự thay đổi đáng kể mà chỉ khi chúng 
ta tập thể dục mạnh đến mức khó điều 
chỉnh giọng nói, hơi thở.

Quang thoại 

Rầy bông xoài

Rầy bông xoài

Tập thể dục giúp tăng cường sức khỏe
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Có thể nói WinRAR là phần 
mềm có mặt ở hầu hết mọi 
máy tính sử dụng hệ điều hành 
Windows. Đây là chương trình 
thực hiện việc nén, giải nén dữ 
liệu với phần mở rộng như: RAR, 
ZIP, ISO, TAR, 7-Zip… Bạn có 
thể tải phiên bản mới nhất của 
WinRAR tại địa chỉ: http://www.
rarlab.com/download.htm. Bài 
viết sẽ đề cập việc sử dụng hiệu 
quả công cụ nén và giải nén 
thông dụng này. 

1. Nén và giải nén “tốc 
hành” tập tin, thư mục chứa 
dữ liệu

Sau khi cài đặt chương trình 
vào máy tính bạn sẽ thấy ở menu 
ngữ cảnh sẽ xuất hiện thêm các 
tùy chọn của chương trình. Để 
nén nhanh một file hay thư mục 
bất kỳ, bạn chỉ việc nhấn chuột 
vào nó và chọn Add to “tên tập 
tin.rar” ở menu hiện ra.

Trong trường hợp cần giải 

nén các tập tin đã được nén và 
chia sẻ từ Internet. Bạn nhấn 
chuột phải vào tập tin trên, chọn 
Extract Here. Lập tức dữ liệu 
sẽ được trích xuất và hiện diện 
ngay bên cạnh tập tin nén gốc.

2. Tạo file nén tự giải nén 

và tùy biến chế độ nén
Nhấn chuột phải vào file, 

thư mục cần nén, chọn Add to 
archive. Ở giao diện cửa sổ 
hiện ra, bạn đánh dấu chọn 
trước mục Creat SFX archive ở 
khung 

Archiving options. Tiếp đó 
bạn chọn mức nén (tỷ lệ với 
dung lượng sau khi nén) ở 
Compression method. Nơi đây 
bao gồm các phương thức nén 
nhanh (Fastest) và nén với dung 
lượng nhỏ nhất (Best).

3. Tùy chọn nâng cao và 
tùy chỉnh menu ngữ cảnh 

Nếu bạn muốn bảo mật cho 
file được nén thì việc đó sẽ 
được thực 
hiện hết sức 
nhanh chóng. 
Nhấn chuột 
phải vào file, 
thư mục cần 
nén với chế độ 
bảo mật, chọn 
Add to archive. 
Ở cửa sổ hiện 
ra, bạn chọn 
thẻ Advanced. 

Bấm vào nút Set password. Sau 
đó bạn điền mật khẩu vào khung 

Enter password. Cuối cùng bấm 
OK hai lần để hoàn tất và đóng 
lại các cửa sổ.

Thông thường sau khi cài đặt 
WinRAR vào máy tính, mỗi khi 
sử dụng menu chuột phải bạn 
sẽ trông thấy những chức năng 
không cần thiết được tích hợp 
làm rối mắt mỗi khi mở lên. Để 
tinh giản menu này bạn mở giao 
diện chính của WinRAR,  chọn 
Options> Settings. Tại giao 
diện Settings, bạn nhấn vào 
thẻ Integration. Bấm tiếp vào 
nút Context menu items. Ở cửa 
sổ hiện ra, bạn sẽ bỏ dấu chọn 
trước các thành phần không cần 
tích hợp vào menu ngữ cảnh .

ĐOÀN LÂM TẤT LINH 
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AirDroid là một ứng dụng cho hệ 
điều hành Android, nó sẽ giúp thay 
thế cáp USB của thiết bị bằng trình 
duyệt web của máy tính. AirDroid 
cho phép bạn dễ dàng chuyển các 
tập tin qua lại giữa thiết bị Android 
và máy tính, gửi tin nhắn văn bản, 
chơi nhạc, xem ảnh của bạn và 
quản lý các ứng dụng… mà không 
cần phải cài đặt bất cứ phần mềm 
nào lên máy tính của bạn. AirDroid 
là một ứng dụng hoàn toàn miễn 
phí, nó thậm chí không chứa các 
quảng cáo. Nó hoạt động như một 
máy chủ web, cho phép thiết bị 
Android của bạn và máy tính của 
bạn để giao tiếp qua mạng Wi-Fi. 
Bạn có thể tải AirDroid từ Android 
Market theo địa chỉ http://tinyurl.
com/bogvgth 

1/ Bắt đầu

Sau khi cài đặt xong AirDroid 
vào thiết bị, bạn hãy khởi động 
chương trình rồi nhấn nút Start để 
bắt đầu khởi tạo máy chủ AirDroid. 
AirDroid sẽ cho bạn biết chính xác 
những gì bạn cần làm, bạn chỉ cần 
nhập địa chỉ IP vừa hiện ra vào 
thanh địa chỉ của trình duyệt web 
trên máy tính của bạn (tốt nhất bạn 

nên dùng trình duyệt chrome của 
google).

Tiếp theo, bạn sẽ thấy một trang 
đăng nhập. Sử dụng password mà 
AirDroid cung cấp để đăng nhập. 
Điều này giúp ngăn chặn các truy 
cập trái phép vào thiết bị Android 
của bạn. 

Lưu ý, nếu bạn không nhìn thấy 
trang đăng nhập thì thiết bị Android 
của bạn và máy tính có thể không 
được kết nối cùng một mạng. Do 
đó, bạn  phải đảm bảo cả hai phải 
cùng kết nối trong cùng một mạng 
máy tính (cùng một hub hoặc 1 
router nếu router có nhiều port 
hoặc cùng một điểm truy cập nếu 
là kết nối Wi-Fi). 

2/ Màn hình chính của AirDroid
Sau khi bạn đã kết nối thành 

công, bạn sẽ thấy trang web chứa 
màn hình làm việc chính của 
AirDroid, trong đó có các liên kết và 
số liệu thống kê về thiết bị của bạn. 
Ở góc dưới cùng bên phải, bạn sẽ 
thấy tình trạng của các kết nối Wi-

Fi, thanh phủ sóng di động và thời 
lượng pin của thiết bị Android.

Nhấn chuột vào liên kết Detail 
để xem thêm thông tin về thiết bị 
lưu trữ của bạn và các tập tin mà 
nó chứa.

3/ Truyền tải và quản lý tập tin
Nhấn chuột vào biểu tượng File 

trong màn hình chính của AirDroid 
để xem nội dung trên thẻ SD của 
thiết bị. Nếu bạn muốn làm sạch hệ 
thống tập tin của thiết bị, bạn nên 
xóa các tập tin từ đây bởi tốc độ 
sẽ nhanh hơn so với chương trình 
quản lý tập tin trên thiết bị Android. 

Sử dụng menu chuột phải để 
quản lý các tập tin – Chọn Delete 
để xóa vĩnh viễn một tập tin, hoặc 
chọn Export để tải chúng vào máy 
tính của bạn. Export as cho phép 
nén các tập tin thành một file ZIP 
duy nhất trước khi chép nó vào máy 
tính. Sử dụng nút Import để thêm 
tập tin vào thiết bị Android của bạn 
mà không cần dây cáp USB./.

Còn nữa
Võ Xuân Vỹ



Chắc hẳn, những người yêu 
nhạc jazz ở Việt Nam đã từng than 
phiền rất khó khăn để có thể tiếp 
cận với những bài hát nhạc jazz ở 
thế giới. Tuy nhiên, khi radio online 
đã trở nên khá quen thuộc thì vấn 
đề trên trở nên rất dễ dàng. Bạn có 
thể dễ dàng lưu lại những bài hát 
jazz được phát sóng online trên 
radio online 24h/7 ngày và để dành 
nghe từ từ. Chỉ cần trang web dẫn 
tới liên kết radio online và chương 
trình Station Ripper là bạn có thể tận 

hưởng nhạc jazz (hay bất cứ thể loại 
nhạc nào khác) .

Bước 1:
Bạn cần tải phần mềm Station 

Ripper 2.98 từ trang chủ http://www.
stationripper.com (khoảng 2.8MB). 
Chương trình miễn phí, tuy nhiên để 
có đầy đủ các tính năng thì bạn cần 
mua bản quyền phần mềm với giá 
$19.99 cho bản Standard và $29.99 
cho bản Gold. Bản Standard và bản 
Gold cho phép bạn ghi lại cùng lúc 
600 kênh radio online,podcast khác 

nhau, cho phép bạn ghi lại các kênh 
radio online nổi tiếng như Shoutcast, 
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Cây su hào (củ thò lò)

Đặc tính sinh học: Thân cây phình 
to ra làm củ khi sinh, trong chứa rất 
nhiều sinh tố, nên được dùng làm 
thực phẩm rất tốt. su hào không đòi 
hỏi nhiều về đất và phân bón.

Su hào thường có 3 giống:

+ Su hào dọc tăm hay su hào 
trứng, củ bé tròn, cọng lá nhỏ, phiến 
lá mỏng và bé. Thời gian sinh trưởng 
từ gieo đến thu hoạch 75-80 ngày.

+ Su hào dọc nhỡ, củ tròn, to, 
mỏng vỏ, cọng và cuống lá bự hơn, 
dày hơn loại dọc tăm. Thời gian sinh 
trưởng 90-105 ngày.

+ Su hào dọc đại (su hào bánh 
xe): củ to, hơi dẹt, vỏ rất dày, cọng 
và phiến lá rất to. Thời gian sinh 
trưởng 120-130 ngày.

Thời vụ gieo trồng:

* Vụ sớm: gieo từ tháng 7, tháng 
8 chủ yếu là su hào trứng; tuổi cây 
giống 25 ngày

* Vụ chính: gieo tháng 9 đến hết 
tháng 10; dùng giống su hào nhỡ và 
su hào dọc đại để thu hoạch được 
dài; tuổi cây giống 30-35 ngày.

* Vụ muộn: gieo tháng 11; chủ 
yếu cho loại su hào dọc tăm và một 
phần loại dọc nhỡ để có thể kéo dài 
thu hoạch đến tháng 4 năm sau; tuổi 
cây giống 25-30 ngày.

Chăm sóc: bón lót bằng các 
phân hoai, mục hay compost trộn 
với phân lân, kali, rải lên mặt luống 
khi làm đất ( 20-25 g phân hóa học 
cho 10 m2 mặt luống).

Sau khi trồng xong phải tính tưới 
nước ngay; sau đó tưới 2 lần vào 
sáng sớm và chiếu mát; 7 ngày sau 
khi cấy thì bón thúc và tưới tiếp (để 
giử độ ẩm 75-85% trong suốt thời kì 
sinh trưởng).

Bón thúc: pha 80-100 g phân 
đạm vào nước (20% độ loãng) cho 
10 m2 mặt luống. Kết hợp xáo xới 
đất: lần đầu sau khi ra ngôi 15-20 
ngày, lần thứ 2 sau đó 15 ngày.

Thu hoạch su hào: căn cứ vào 
thời gian sinh trưởng của từng giống, 
từng vụ và thấy mặt củ đã bằng, lá 
non dừng sinh trưởng thì thu hoạch. 
Để thêm nữa sẽ thì thu hoạch. Để 
thêm nữa sẽ hóa già, nhiều xơ, giảm 
phẩm chất. Năng suất khoảng 16-30 
kg cho 10 m2 (còn nữa).

Nguyễn Anh Thư
Hội Hóa học Đồng Nai

Su hào

Luống su hào
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của cả hai được hình thành một 
cách hòa hợp.

Tại sao không phải tất cả các 
loài kiến đều cộng sinh với cây ổ 
kiến mà chỉ có một vài loài mới 
có khả năng này. Những nghiên 
cứu về dược tính  từ cây ổ kiến 
Hydnophytum formicarum đã cho 
thấy cây ổ kiến không thể chấp 
nhận một số loài kiến đến chỉ mong 

tấn công phần lớp củ và dưỡng 
chất mà nó tiết ra. Hẳn nhiên nó chỉ 
cần những loài cần sống cộng sinh, 
cùng có lợi trên cơ chế phát triển 
của chúng sinh. Chúng sản sinh ra 
những loài chất độc mà chỉ có một 
vài loài kiến mới có khả năng ăn 
các chất dẫn dụ mà thôi.

TÁC DỤNG CỦA CÂY Ổ KIẾN 
ĐỐI VỚI CON NGƯỜI 

Theo kinh nghiệm của đồng bào 
Êđê ở Tây Nguyên, Bí kỳ nam được 
dùng làm thuốc chữa bệnh gan, 
vàng da, bệnh của phụ nữ sau khi 
đẻ. Ngoài ra, một vài lát bí kỳ nam 
đem giã nhỏ, hấp với đường cho 
trẻ uống để chữa ho. Để chữa thấp 

khớp, đau nhức gân xương, vết tụ 
máu bầm tím. Mặc dù loài này đã 
được đưa vào sách đỏ Việt Nam 
nhằm bảo về nguồn gen quí hiếm 
và độc đáo trong kho tàng thiên 
nhiên của chúng ta. Tuy nhiên nạn 
khai thác dùng làm thuốc quá mức 
nên cây vốn hiếm gặp, lại bị thu hái 
buôn bán, nên số lượng ngày càng 
bị giảm sút.  Nhằm bảo vệ loài thực 
vật kỳ bí này rất cần những bàn 
tay của cộng đồng chúng ta trong 
việc bảo vệ không chỉ với loài thực 
vật này mà còn cả những loài khác 
đang chung sống trong căn nhà 
thiên nhiên hoang dã Việt Nam 

Phùng Mỹ Trung

Cây sen được trồng phổ biến ở 
nhiều làng quê Việt Nam, là loại cây 
vừa làm cảnh, làm thực phẩm và làm 
thuốc. Các bộ phận của cây sen từ 
rễ, thân, lá, hoa, hạt… đều có tác 
dụng chữa bệnh.

Tên khoa học: Nelumbo nucifera 
Gaerin. Nelumbonaceae (họ Sen)

Đặc điểm thực vật: Cây mọc 
dưới nước, thân rễ, hình trụ mọc ở 
trong bùn – thường gọi là ngó sen. Lá 
mọc lên khỏi mặt nước, cuống lá dài, 
có gai nhỏ. Phiến là hình khiên hay 
tròn, to, có gân tỏa tròn, mép lá uốn 
lượn. Hoa to màu trắng hay đỏ hồng, 
hoa đều, lưỡng tính, đài 3-5, màu lục, 
trắng gồm rất nhiều cánh hoa màu 
hồng hay trắng một phần. Có nhiều 
lá noãn rời nhau đựng trong một đế 
hoa loe ra thành hình nón ngược gọi 
là gươn sen. Qủa kép gồm nhiều quả 
bế, mỗi lá noãn có 1-2 tiểu noãn. Qủa 
chứa 1 hạt không nội nhũ, 2 lá mầm 
dầy, chồi mầm gồm 4 lá non gập vào 
phía trong. 

Bộ phận dùng: 		
Fructus Nelumbinis: (Liên thạch) 

là quả già đã phơi khô. Bóc vỏ bằng 

cách ngâm liên thạch vào nước ấm 
1-2 giờ, vớt hạt ra, dùng dao chặt nhẹ 
theo chiều ngang từng hạt, tách bỏ vỏ 
cứng ngoài, lấy riêng liên tâm, còn lại 
là liên nhục.

- Semen Nelumbinis: (Liên nhục) 
là hạt còn màng mỏng của quả già 
đã phơi khô, độ ẩm không quả 14%, 
tro toàn phần không quá 4,5%, hạt vỡ 
đôi, vỡ ba không quá 10%.

- Embryo Nelumbinis: (Liên tâm) 
là cây mầm lấy trong quả sen đã phơi 
khô, độ ẩm không quá 5%, tạp chất 
không quá 0,5%.

- Folium Nelumbinis: (Liên diệp) 
thu hái lá bánh tẻ vào mùa thu, bỏ 
cuống phơi khô, độ ẩm không quá 
13%, tạp chất không quá 0,5%, vụn 
nát (qua rây 36) không quá 5%, 

Tieáp theo trang 8

Hình 1: hoa sen hồng

Hình 2: hoa sen trắng

Hình 3: Lá sen
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iTunes Radio,Pandora, last.fm. 
Ngoài ra, sau khi ghi lại bài hát vừa 
phát trên kênh radio, chương trình 
sẽ tự động liên kết với máy chủ để 
tải các thông tin liên quan cho file 
bạn vừa ghi, tạo 1 playlist đồng bộ 
dữ liệu với iTunes.                                                

Sau khi tải chương trình xong, 
quá trình cài đặt sẽ hỏi bạn chọn 
ngôn ngữ nào, ở đây chúng ta chọn 
English và tiến hành cài đặt dễ dàng 
như các chương trình thông dụng. 
Sau khi cài đặt xong, chúng ta mở 
chương trình ra, nếu các bạn đã 
mua bản quyền thì có thể vào Help-
>Register để nhập vào các thông số 
đăng ký bản quyền. Sau khi thực 
hiện bước này xong chúng ta đã có 
tiền đề để thực hiện việc ghi lại các 
chương trình radio online.

Bước 2 : 
Hiện tại, theo đánh giá của trang 

web http://jazzhall.org có 3 trang dịch 
vụ có chất lượng phát sóng nhạc 
Jazz tốt nhất. Đó là Smoothjazz.
org, Sky.fm, Arrowjazz.com. Ở đây, 
người viết chọn trang smoothjazz.
org vì các ca khúc được phát sóng 
từ các nghệ sĩ lão làng cho tới các 
nghệ sĩ mới nổi danh, nghệ sĩ indie. 
Bạn có thể nghe các ca khúc nổi 
tiếng của Miles Davis, Duke Ellington 
cho tới Musica Nuda, Katie Melua 
hay các ca khúc chỉ giới hạn đối với 
người yêu nhạc jazz với đa thể loại. 
Ngoài ra, chương trình còn quảng 
cáo thông tin về những show diễn 
nhạc jazz sắp diễn ra hay về những 
nghệ sĩ mới cho công chúng. 

Bước 3 :
Sau khi đã vào trang web http://

smoothjazz.com                                     
Bạn sẽ thấy 1 banner On-Air đang 

thể hiện bài hát đang phát sóng trên 
radio online của Smoothjazz. Việc 
tiếp theo là bạn kéo xuống, sẽ để 
ý thấy có 1 danh sách các chương 
trình chơi nhạc mà trang web hỗ 
trợ, bao gồm iTunes, Winamp, Real 
Media Player…đi kèm theo đó là 
chất lượng âm thanh mà chúng ta 
muốn nghe trên radio (32K, 64K, 
128K, 256K) Ở đây, người viết chọn 
iTunes và chất lượng 256K. Nhấp 
chuột vào, 1 cửa sổ sẽ hiện ra yêu 
cầu bạn download tập tin để mở 
bằng iTunes.                                                    

Vì mục đích bài viết hướng 
dẫn các bạn có thể thu sóng bằng 
Station Ripper, bước này chúng ta 
sẽ không dùng iTunes để mở (Nếu 
các bạn không muốn thu âm thì có 
thể trực tiếp mở file bằng iTunes để 
nghe trực tuyến) mà sẽ Open with… 
và chỉ tới đường dẫn file thực thi của 
chương trình Station ripper (mặc 
định sẽ là C:\Program Files (x86)\
Ratajik Software\StationRipper\ 
StationRipper.exe) để chương trình 
liên kết tới địa chỉ dẫn tới luồng audio 
(audio streams) của Smoothjazz. 

Ngay sau khi click vào, cửa sổ 
chương trình mở ra sẽ hiện lên 
thông tin về kênh radio online của 
Smoothjazz.org (bài hát đang phát, 
tình trạng hiện tại, dung lượng file đã 
ghi lại, chất lượng file ghi lại…)và sẽ 
tự động ghi lại và lưu lại thành file sau 
khi kênh radio phát xong mỗi bài hát 
(Mặc định đường dẫn chương trình 
sẽ lưu lại file dưới dạng *.mp3 tại 
đường dẫn C:\Program Files (x86)\
Ratajik Software\StationRipper\
Output). Và bạn có thể click vào 
biểu tượng chiếc iPod để có thể đưa 
các bài hát đã ghi vào một playlist 
trong iTunes để có iTunes tự động 
tải và cập nhập thông tin chính xác 
về bài hát thông qua cơ sở dữ liệu 
của iTunes).

Chú ý : Ngoài kênh radio 
Smoothjazz.org, bạn cũng có thể 
thực hiện tương tự đối với các trang 
radio online nêu trên hoặc các trang 
radio khác. Chỉ cần bạn biết được 
địa chỉ phát sóng của kênh radio 
đó, đưa vào ô Address ở góc dưới 
chương trình và nhấn add, nếu đã 
đúng địa chỉ, chương trình sẽ tự 
động thực hiện tương tự đối với 
phương pháp người viết nêu ở trên.

Hy vọng bài viết đã giúp được 
các bạn ưu thích nhạc jazz phần 
nào thỏa mãn được cơn khát nhạc 
jazz và tiếp cận được với những ca 
khúc jazz cổ điển cũng như hiện đại 
của nhạc jazz.  

Lương Gia Định 
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phân chia và lướt các kênh theo thể loại, đồng 
thời giới thiệu các trang kênh mới. Theo đó, khi 
ấn chọn một video nào đó, người dùng cũng có 
thể xem và lướt qua những video có nội dung liên 
quan chỉ với động tác nhấn nút mũi tên lên xuống 
trên thiết bị điều khiển từ xa. Họ cũng có thể bình 
luận, thêm vào danh sách phát hình hoặc bình 
chọn video đó, tất cả thao tác giống hệt như trên 
máy tính, chỉ khác là áp dụng cho ti-vi, với bàn 
tính chính là chiếc remote. Tuy nhiên, đây chỉ là 
phần mở đầu, và Google khẳng định sẽ còn tiếp 
tục tung ra các cải tiến quan trọng về dịch vụ TV.

Google từ lâu đã nói bóng gió về một đợt cập 
nhật toàn diện cho Google TV. Dù là sản phẩm 
chung sức giữa Google, Intel, Sony và Logitech, 
Google TV thật sự là một thảm họa khi được tung 
ra vào tháng 5.2010. Kết quả là Logitech đã rút 
khỏi liên minh này sau khi hứng chịu tổn thất về 
tài chính, làm trì hoãn việc sản xuất bộ giải mã 
tín hiệu Revue Google TV. Đến tháng 10 năm 
ngoái, Google nâng cấp dịch vụ TV lên phiên bản 
Android 3.2 (Honeycomb), và là đợt cải tiến mới 
nhất trước khi Google cập nhật hệ điều hành lên 
phiên bản Android 4.0 (Ice Cream Sandwich) như 
hiện nay. Gần đây, Google đã làm cuộc cải tổ 
toàn diện đối với YouTube, và theo thống kê của 
chính website này, hơn 3 tỉ video đã được truy 
cập mỗi ngày, biến YouTube trở thành website 
chia sẻ video miễn phí lớn nhất thế giới. Trong 
đó, 70% lưu lượng thông tin nằm ngoài Mỹ.

Như vậy, diễn biến mới nhất cho thấy Google 
và Apple chuẩn bị choảng nhau trong lĩnh vực 
TV. Và cuộc tranh tài giữa 2 thế lực công nghệ 
được dự kiến sẽ còn nảy lửa hơn sau khi Ủy ban 
châu Âu và Bộ Tư pháp Mỹ cảnh báo về viễn 
cảnh đụng độ mới giữa Android và iPhone. Sau 
nhiều tháng cân nhắc, 2 cơ quan này vừa cho 
phép Google triển khai thương vụ mua bộ phận 
Motorola Mobility (MMI), với mục đích sở hữu 
17.000 bản quyền sáng chế và 7.500 bằng sáng 
chế đang chờ cấp của nhà sản xuất những chiếc 
điện thoại đầu tiên trên thế giới. Việc sáp nhập 
MMI sẽ cho phép Google cung cấp sự bảo vệ 
pháp lý cho những nhà làm thiết bị di động đang 
sử dụng hệ điều hành Android của hãng này, 
mang lại lợi thế quan trọng cho Google trước 
Apple. 

Trở lại trận chiến về mảng TV, Google đang 
lên kế hoạch tổng tấn công vào thế giới giải trí tại 
nhà. Trong tương lai gần, người xem có thể vẽ ra 
một viễn cảnh, trong đó thiết bị truyền hình có thể 
được kết nối với máy quay video, cho phép các 
nhà cung cấp dịch vụ giới thiệu một hệ sinh thái 
có thể tương thích với các smartphone và máy 
tính bảng chạy Android.

MINH QUANG

Tieáp theo trang 1
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cuống lá còn sót lại không quá 2%.
- Stamen Nelumbinis: (Liên tu) 

tua nhị và bao phấn đã phơi khô, độ 
ẩm không quá 13%, tạp chất không 
quá 0,5%

- Nodus Nelumbinis Rhizoma: 
(Liên ngẫu) là thân rễ tươi hay phơi 
khô, độ ẩm không quá 10%, tạp chất 
không quá 0,5%.

- Recaptaculum Nelumbinis: 
(Liên phòng) dùng gương sen già sau 
khi đã lấy hết quả đóng phơi khô.

Thành phần hóa học:
- Liên nhục có protid, lipid, đường, 

tinh bột.
- Liên tâm có alcaloid là licimin, 

isoliencimin, neferin, lotucin.
- Liên diệp có alcaloid là nuciferin, 

nor – nuciferin, pronuciferin, 

dehydronuciferin, roemerin, 
dehydroroemerin, anonain, 
dehydroanonai, flavonoid là 
quercetin, tanin.

- Liên tu có chất thơm, tanin.
- Liên ngẫu có protein, vitamin, 

đường.
- Liên phòng có Flavonid là 

quercetin.
Công dụng: 
- Liên thạch dùng chữa lỵ, cấm 

khẩu.
- Liên nhục: làm thuốc bổ, 

chữa tỳ hư, thận yếu, di tinh, mất 
ngủ, thần kinh suy nhược, trẻ em 
chậm lớn, quấy khóc.

- Liên tâm: chữa tim hồi hộp, 
mất ngủ, di mộng tinh, thổ huyết, 
phiền khát.

- Liên diệp chữa đại tiểu tiện ra 
máu, kiết tả do thử thấp.

- Liên tu: chữa băng huyết, 
thổ huyết, di mộng tinh, an thần

- Liên phòng: làm thuốc cầm 
máu.  Dùng để chữa bệnh đại tiện 
ra máu, chữa ứ huyết đau bụng, 
băng huyết, tiểu tiện ra máu. 

- Liên ngẫu: làm thức ăn, 
thuốc cầm máu. Dùng trong các 
trường hợp đi ngoài ra máu, tiểu 
tiện ra máu, nôn ra máu, chảy 
máu cam, tử cung xuất huyết.

Cách dùng: 
Tâm sen (còn gọi là Liên tử 

tâm): Vị đắng tính hàn, có tác 
dụng thanh tâm trừ phiền, chỉ 
huyết sáp tinh. Dùng an thần, 
trị sốt cao mê sảng, hồi hộp tim 
đập nhanh, huyết áp cao. Thường 
dùng phối hợp với một số vị thuốc 
khác như cúc hoa, hoa hòe, hạt 
muồng... pha trà uống để dễ ngủ, 
hạ áp. Liều dùng 1,5-3g.

Tua sen (Liên tu): Vị ngọt sáp, 
tính bình, tác dụng thanh tâm cố 
thận, sáp tinh chỉ huyết. Dùng 

riêng hoặc phối hợp với hạt sen. 
Liều thường dùng 1,5-5g.

Gương sen (Liên phòng): Vị 
đắng sáp, tính ôn, có tác dụng 
tiêu ứ chỉ huyết, dùng trị các 
chứng băng lậu ra máu, tiểu ra 
máu... Thường dùng để cầm máu 
bằng cách đốt thành than rồi phối 
hợp với các vị thuốc khác. Liều 
dùng 5-10g.

Lá sen: có chất ancaloid làm 
dịu đau, an thần, chống co giật, 
giải nhiệt, trừ cảm nắng, làm 
thuốc cầm máu, chữa thổ huyết, 
băng huyết, mất ngủ. 

- Chữa mất ngủ: Lá sen sắc 
đặc pha chút đường, uống trước 
khi đi ngủ khoảng 2 giờ sẽ ngủ 
ngon.

Sau đây là một số bài thuốc trị 
bệnh từ các bộ phận của cây sen:

+ Trị nôn ra máu: lá sen 15g, 
ngó sen 15g, cỏ nhọ nồi 20g. Cho 
các vị vào nồi, đổ 3 bát nước sắc 
còn 1 bát, chia 2 lần uống trong 
ngày.

+ Trị chảy máu cam: ngó sen 
rửa sạch, giã vắt nước cốt uống, 
nhỏ vài giọt vào mũi.

+ Trị trẻ biếng ăn, người lớn 
suy nhược, ăn kém: hạt sen 
100g, đậu ván trắng 10g, trần 
bì 12g, mầm lúa 30g. Tất cả sao 
qua, tán mịn, ngày uống 3 lần 
mỗi lần 100g, uống với nước cơm.

+ Trị viêm mũi, ngạt mũi lâu 
ngày: cánh hoa sen thái chỉ phơi 
khô 100g, bạch chỉ 100g. Tất 
cả tán mịn, cuốn giấy như cuốn 
thuốc, hút phả khói ra mũi liên 
tục trong vòng 1 tuần.

+ Trị đau lưng, mệt mỏi: nhụy 
sen 4g, cam thảo 6g. Tất cả cho 
vào nồi, đổ 3 bát nước sắc còn 1 
bát, uống trước khi đi ngủ.

Hoài Thương
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Hình 4: Hạt sen

Hình 5: Tâm sen


